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What is vCapture Express for Acuity? 

 

vCapture Express for Acuity is an application that can print Acuity assessment forms 

(optionally with pre-populated data from Acuity roster files) and scan and capture data 

from completed test forms for export to the Acuity system.  The vCapture software is 

only installed on the computer attached to the scanner. 

 

System Requirements 
 

vCapture Express for Acuity has been designed for the following operating systems: 

• Windows 2000 

• Windows XP 

 

Minimum Supported Requirements 

• All image based scanners using TWAIN scanner drivers.  Most popular image 

based scanners include: 

o Fujitsu 

o Brother 

• 256 MB RAM 

• 100 MB free hard drive space 

• Pentium 3 or greater – 500 Mhz or more 

• True Color Video Card (24 or 32 bits – 16.8 Million colors) – 1024x768 
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Installation Instructions 
 

The instructions for installing vCapture Express for Acuity contain the following 

sections. 

• 1.1  Launching the Installer 

• 1.2  Prerequisites 

• 1.3  Installer Screens 

• 1.4  Uninstalling 

 

1.1 Launching the Installer 
 

To install vCapture Express for Acuity, double-click the installer icon, 

vCaptureExpressSetup.exe.  This launches the installer application that will install 

vCapture Express for Acuity. 

 

1.2 Prerequisites 
 

vCapture Express for Acuity requires the .NET 2.0 Framework and Adobe Acrobat 

Reader 5.2 or later.  If either prerequisite is not detected when the installer is launched, 

the Prerequisites dialog appears and prompts the user to install the necessary prerequisite. 

 

 
 

.NET 2.0 Framework 

 

vCapture Express for Acuity requires the .NET 2.0 Framework.  If the installer detects that 

the .NET 2.0 Framework is not installed, the user is prompted to install it.  This launches 

the .NET 2.0 Framework installer.   
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Click Next and follow the prompts and instructions to install the .NET 2.0 Framework. 

 

Adobe Acrobat Reader 

 

vCapture Express for Acuity requires Adobe Acrobat Reader 5.2 or later in order to print 

Assessment test forms.  If the installer detects that Adobe Acrobat Reader 5.2 or later is not 

installed, the user is prompted to install Adobe Acrobat Reader.  (Adobe Acrobat Reader 

5.2 will be installed on Windows 98, Adobe Acrobat Reader 6.0 will be installed on 

Windows 98 SE and Windows 2000 or later). This launches the Adobe Acrobat Reader 

installer. 
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Click Next and follow the prompts and instructions to install Adobe Acrobat Reader. 
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1.3 Installer Screens 
 

After installing any prerequisites, the installer will display the primary vCapture Express 

for Acuity installer screens. 

 

Welcome Screen 

 

The welcome screen introduces the user to the vCapture Express for Acuity installer. 

 

 
 

Click Next to proceed with the installation. 

 

License Agreement 

 

The license agreement screen prompts the user to accept the terms of the vCapture 

Express software license agreement. 
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Read the terms of the software license agreement, click I accept the terms in the license 

agreement, and click Next to continue with the installation.   

 

Optionally, click Print to print out the terms of the software license agreement. 

 

Choose Destination Folder 

 

The destination folder screen prompts the user to accept or change the location in the file 

system where vCapture Express for Acuity will be installed. 

 

 
 

To change the location from the default, click the Change button and select a folder in 

the file system where vCapture Express for Acuity will be installed. 

 

To accept the default location, or once the location has been changed, click Next to 

continue with the installation. 

 

Choose Default Roster File Location 

 

The default roster file screen prompts the user to accept or change the location in the file 

system where vCapture Express for Acuity will look for Acuity roster files.  This location 

will not prevent the user from browsing for roster files when vCapture Express for Acuity 

is run, it is simply the first place that the user will be taken to when loading roster files. 
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To change the location from the default, click the Change button and select a folder in 

the file system where vCapture Express for Acuity will look for Acuity roster files. 

 

To accept the default location, or once the location has been changed, click Next to 

continue with the installation. 

 

Ready To Install Screen 

 

The ready to install screen tells the user that the installer is prepared to install vCapture 

Express for Acuity. 

 

 
 

Click Install to proceed with the installation. 

 

Finished Install 

 

The finished install screen informs the user that the installer has completed. 

 



Copyright © 2008 by PaperFree Corporation 10 

 
 

Click Launch vCapture Express to close the installer and immediately start vCapture 

Express for Acuity.   

 

Click Finish to close the installer. 
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1.4 Uninstalling 
 

To uninstall vCapture Express for Acuity from a computer, do the following. 

 

1. In Windows, go to the Add or Remove Programs control panel. 

2. Find the entry for vCapture Express and click the Remove button. 

 

 
 

3. Follow the prompts to remove vCapture Express for Acuity. 
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2 Getting Started 
 

To get started with vCapture Express for Acuity quickly, read the quick start topics in this 

section. 

• 2.1  Launching the Application 

• 2.2  Welcome Screen 

• 2.3  Loading a Roster File 

• 2.4  Printing Forms 

• 2.5  Scanning and Processing Completed Forms 
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2.1 Launching the Application 
 

There are two ways to launch vCapture Express for Acuity:  Use the installed shortcut or 

launch the executable from Windows Explorer. 

 

Launching vCapture Express for Acuity from the installed shortcut 

 

1. Click on the Start button in the Windows task bar. 

2. Click on All Programs from the pop up menu. 

3. Find the vCapture Express directory from the list and click on it. 

4. Click on vCapture Express from the resulting list to launch the application. 

 

 
 

Launching vCapture Express for Acuity from Windows Explorer 

 

1. Type WinKey-E to launch a new Windows Explorer window. 

2. In the Address bar type C:\Program Files\Virtual Solutions Inc\vCapture 

Express (or the location chosen at install time if different). 

3. Double click the executable vCapture Express.exe to launch the application. 



Copyright © 2008 by PaperFree Corporation 14 

2.2 Welcome Screen 
 

After launching vCapture Express for Acuity, the splash screen appears while the 

application initializes.    

 

When the application has initialized, the main application window appears, with the 

Welcome Screen appearing over it.  

 

 
 

The Welcome Screen explains the three main tasks that can be accomplished directly 

with vCapture Express for Acuity. 

 

1. Loading an Acuity roster file into vCapture Express for Acuity 

2. Printing test forms for the Acuity assessment system. 

3. Scanning and processing completed assessment forms. 

 

To prevent the Welcome Screen from appearing on subsequent launches of vCapture 

Express for Acuity, click the checkbox labeled Don’t show this dialog again. 

 

Click the OK button or the X button in the upper right hand corner of the Welcome 

Screen to close it and proceed with using vCapture Express for Acuity. 
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2.3 Loading an Acuity Assignment Roster File 
 

There are a number of ways to load an Acuity assignment roster file into vCapture 

Express .  When printing or scanning, the application always presents an option to load a 

roster file at that time.  However, the easiest way to load a roster file is presented here. 

 

1. A roster file must have previously been created from the Acuity assessment 

system.  See the Acuity Administrator Guide for details.  When saving the 

Acuity assignment roster file to the scanning station, use a naming convention 

that will allow you to identify the assignment easily. 

2. Click the Load Roster button from the main vCapture Express for Acuity 

toolbar. 

 

 
 

3. The Load Acuity Roster File appears.  The default directory was specified at 

install time.  If the desired roster file is not at this default directory, browse to 

the directory on the file system where the desired roster file is located. 

 

 
 

4. Select the desired roster file and click Open.   
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5. If the roster file is correctly formatted, a message box appears to confirm this. 

 

 
6. Click OK to confirm that the roster file was loaded. 

7. The status bar at the bottom of the screen is updated with the path of the loaded 

roster file. 
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2.4 Printing Student Answer Sheets 
 

There are number of options for the printing of Acuity assessment answer sheets with 

vCapture Express for Acuity.  To see the full range of options, look at the How To… 

section later in this document. 

 

This section describes the most common options for printing Acuity assessment answer 

sheets with a loaded Acuity roster file from vCapture Express for Acuity. 

 

1. Click the Print Tests button from the main vCapture Express for Acuity toolbar. 

 

 
 

2. The vCapture Express – Print dialog appears with a number of options to 

choose. 

 

 
 

3. In the Printer section, the current default printer is selected.  To choose a 

different printer, click on the drop down arrow and select the desired printer. 
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4. In the Test Template section, the current test template to be printed is selected.  

To choose a different test template to print, click on the drop down arrow and 

select the desired test template. 

 

 
 

5. In the Roster File section, the path to the currently loaded Acuity roster file is 

displayed (if no roster file is loaded, this path is blank).  To load an Acuity roster 

file, click Browse and choose the desired roster file. 

6. Once a roster file is loaded, the checkbox Pre-populate forms from roster file is 

checked.  With this box checked, the student number and test number of each 

printed form will be filled out with one line from the roster file. 

 
 

7. The Test Number section is set to Use roster file to indicate that the pre-printed 

test number will be pulled from the lines of the roster file. 
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8. In the Copies section, the Forms to print counter is disabled and the number of 

lines in the loaded roster file is displayed. 

9. Click Print to initiate the printing process.  This brings up a dialog that displays 

the progress in preparing the forms that will be printed and sending the forms to 

Adobe Acrobat Reader for printing. 

 

 
 

10. Once the forms have been prepared, Adobe Acrobat Reader is launched and the 

forms are sent to that application for printing. 

11. When the forms have been spooled to the printer, the progress dialog disappears 

and printing will begin when the printer is ready. 
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2.5 Scanning and Processing Completed Forms 
 

The primary use of vCapture Express for Acuity is to scan filled out assessment answer 

sheets and capture the information for export into the Acuity assessment system.  This 

section describes one straightforward way to use vCapture Express for Acuity to 

accomplish this. 

 

Scan completed assessment answer sheets into vCapture Express for Acuity 

 

1. Prepare a stack of paper assessment answer sheets that are all of the same 

template type and have been filled out.  Place the paper on a scanner that is 

attached to the computer on which is installed vCapture Express for Acuity. 

2. Within vCapture Express for Acuity, click the Begin Scanning button from the 

main vCapture Express for Acuity toolbar. 

 

 
 

3. The Choose Form Template and Roster File dialog appears. 

 

 

 

4. In the Form Template section, choose the test template that matches ALL of the 

paper assessment tests to be scanned (All the tests to be scanned MUST be of the 

same template type). 

 

 
 

5. In the Roster File section, if the Acuity roster file that matches the tests to be 

scanned is not currently loaded, click the Browse button and choose the desired 

Acuity roster file. 

6. Click the OK button to begin scanning on the computer’s default scanner.  The 

toolbar will change with the Begin Scanning button becoming the Stop Scanning 

button.  It may take a few moments for the scanner to warm up. 
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7. Once the scanner begins scanning, the images will begin to appear in vCapture 

Express one at a time. 

 

 
 

8. When the scanner has finished scanning, the Stop Scanning button becomes the 

Resume Scanning button, and the Process Images button is enabled. 

 

 
 

Once scanning is completed, process the images to export the data 

 

1. Click the Process Images button to begin the data export process. 

 

 
 

2. The Process Images message box appears.  Click OK to begin processing. 
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3. The Processing Progress dialog appears and displays the progress through the 

steps of Preparing Images, Analyzing Images, Reading Data, and Completing. 

 

 
 

4. If there are any data validation errors, the Invalid Data message box appears.  

Click OK to continue.   

 

 
 

5. For each image that has data validation errors, one or more of the following data 

validation dialogs will appear. 

a. If a scanned answer sheet is not of the same test template type chosen at 

the beginning of scanning, the Invalid Identification dialog appears.  

Choose Discard Image and click OK to remove this image from the 

current list of images to be exported. 
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b. If a scanned test has no filled in answers that can be detected, the No 

Answers dialog appears.  Choose Discard Image and click OK to remove 

this image from the current list of images to be exported. 

 

 
 

c. If a scanned test has a student number that does not appear in the loaded 

Acuity roster file, the Correct Data – Student Number dialog appears.  

Enter the correct value for the student number of the image that is 

presented, and click OK, or click Ignore Issue if the capture student 

number is correct. 
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d. If a scanned test has a test number that does not appear in the loaded 

Acuity roster file, the Correct Data – Test Number dialog appears.  

Enter the correct value for the test number of the image that is presented, 

and click OK, or click Ignore Issue if the capture test number is correct. 

 

 
 

6. After all data has been validated, or if there are no validation errors, the Data 

Capture Complete message box appears.  Click OK to choose an export file 

location. 

 

 
 

7. The Save Acuity Export File dialog appears.  Choose a location and file name 

(or accept the defaults) and click Save. 
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8. The Reset vCapture Express dialog appears.  Click Yes to reset vCapture 

Express for Acuity and complete the data export process. 

 

 
 

9. Upload the saved data file into Acuity.  In the Acuity assessment system, use the 

Upload Scanned Answer Sheet menu to load the data file into Acuity for scoring. 

See the Acuity Administrator Guide for details. 
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3 How To… 
 

To learn how to accomplish various tasks with vCapture Express for Acuity, read the 

“how to” topics in this section. 

• Load a Roster File 

• Print Blank Test Forms 

• Print Test Forms Pre-Populated From an Acuity Roster File 

• Choose a Scanner 

• Change a Scanner’s Configuration 

• Resume Scanning 

• Save Exception Images 

• Discard Exception Images 

• Load Exception Images 

• Discard All Current Images 
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3.1 Load a Roster File 
 

To load an Acuity roster file into vCapture Express for Acuity, perform the following 

steps. 

 

1. A roster file must have previously been created from the Acuity assessment 

system. 

2. Click the Load Roster button from the main vCapture Express for Acuity toolbar. 

 

 
 

3. The Load Acuity Roster File appears.  The default directory was specified at 

install time.  If the desired roster file is not at this default directory, browse to the 

directory on the file system where the desired roster file is located. 

 

 
 

4. Select the desired roster file and click Open.   

5. If the roster file is correctly formatted, a message box appears to confirm this. 

 

 
6. Click OK to confirm that the roster file was loaded. 
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The status bar at the bottom of the screen is updated with the path of the loaded roster 

file. 
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3.2 Print Blank Test Forms 
 

To print blank test forms in vCapture Express for Acuity, perform the following steps. 

 

1. Click the Print Tests button from the main vCapture Express for Acuity toolbar. 

 

 
 

2. The vCapture Express – Print dialog appears with a number of options to 

choose. 

 

 
 

3. In the Printer section, the current default printer is selected.  To choose a 

different printer, click on the drop down arrow and select the desired printer. 
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4. In the Test Template section, the current test template to be printed is selected.  

To choose a different test template to print, click on the drop down arrow and 

select the desired test template. 

 

 
 

5. If a roster file is loaded in the Roster File section, uncheck the checkbox Pre-

populate forms from roster file (if no roster file is loaded, this option is 

disabled). 

6. In the Test Number section, leave the Test Number box blank. 

7. In the Copies section, set the Forms to print counter to the number of forms that 

should be printed. 

8. Click Print to initiate the printing process.  This brings up a dialog that displays 

the progress in preparing the forms that will be printed and sending the forms to 

Adobe Acrobat Reader for printing. 

 

 
 

9. Once the forms have been prepared, Adobe Acrobat Reader is launched and the 

forms are sent to that application for printing. 

10. When the forms have been spooled to the printer, the progress dialog disappears 

and printing will begin when the printer is ready. 
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3.3 Print Test Forms Pre-Populated From an 

Acuity Roster File 
 

To print test forms with pre-populated data from an Acuity roster file in vCapture 

Express for Acuity, perform the following steps. 

 

1. Click the Print Tests button from the main vCapture Express for Acuity toolbar. 

 

 
 

2. The vCapture Express – Print dialog appears with a number of options to 

choose. 

 

 
 

3. In the Printer section, the current default printer is selected.  To choose a 

different printer, click on the drop down arrow and select the desired printer. 
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4. In the Test Template section, the current test template to be printed is selected.  

To choose a different test template to print, click on the drop down arrow and 

select the desired test template. 

 

 
 

5. In the Roster File section, the path to the currently loaded Acuity roster file is 

displayed (if no roster file is loaded, this path is blank).  To load an Acuity roster 

file, click Browse and choose the desired roster file. 

6. Once a roster file is loaded, the checkbox Pre-populate forms from roster file is 

checked.  With this box checked, the student number and test number of each 

printed form will be filled out with one line from the roster file. 

7. The Test Number section is set to Use roster file to indicate that the pre-printed 

test number will be pulled from the lines of the roster file. 

8. In the Copies section, the Forms to print counter is disabled and the number of 

lines in the loaded roster file is displayed. 

9. Click Print to initiate the printing process.  This brings up a dialog that displays 

the progress in preparing the forms that will be printed and sending the forms to 

Adobe Acrobat Reader for printing. 

 

 
 

10. Once the forms have been prepared, Adobe Acrobat Reader is launched and the 

forms are sent to that application for printing. 

11. When the forms have been spooled to the printer, the progress dialog disappears 

and printing will begin when the printer is ready. 
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3.4 Choose a Scanner 
 

To choose a scanner to use from vCapture Express for Acuity, perform the following 

steps. 

 

1. Select Choose Scanner from the Scan menu. 

 

 
 

2. Clicking the menu item brings up the Select Scanner dialog. 

  

 
 

3. Choose the scanner to be used and click Select to make the choice. 
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3.5 Change a Scanner’s Configuration 
 

To change a scanner’s configuration before scanning, perform the following steps. 

 

1. Select Hide Configuration from the Scan menu to toggle whether the 

scanner’s configuration dialog should appear when scanning is initialized.  

The default is for this to be toggled on such that the configuration will not 

appear. 

 
 

2. Click the Begin Scanning button from the main vCapture Express for Acuity 

toolbar. 

 

 
 

3. The Choose Form Template and Roster File dialog appears.  Choose the 

desired Template and optionally browse for a roster file.   

 

 
 

4. Click OK.  The current scanner’s Configuration dialog will appear.  Change 

any settings that the scanner provides, and proceed through the dialog.   

5. Scanning will proceed as described elsewhere in this file, with the selected 

scanner configuration. 
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3.6 Resume Scanning 
 

To resume scanning after scanning has stopped, or after an error with the scanner, 

perform the following steps. 

 

1.  When the scanner has finished scanning, the Stop Scanning button on the main 

toolbar becomes the Resume Scanning button. 

 

 
 

2. Click Resume Scanning on the main toolbar to proceed with scanning. 

3. The toolbar will change with the Resume Scanning button becoming the Stop 

Scanning button.  It may take a few moments for the scanner to warm up. 
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3.7 Save Exception Images 
 

During the processing of the scanned images, data validation exceptions may occur.  One 

of the options for dealing with a data validation exception is to save the exception image 

for later processing.  This removes the image from the current group of images, excludes 

the image from the export file, and saves the image to the file system.   

 

To save an image as an exception image, perform the following steps. 

 

1. For each image that has data validation errors, one or more of the following data 

validation dialogs will appear. 

 

a. If a scanned test is not of the same test template type chosen at the 

beginning of scanning, the Invalid Form Type dialog appears.  Choose 

Save as Exception Image and click OK. 

 

 
 

b. If a scanned test has no filled in answers that can be detected, the No 

Answers dialog appears.  Choose Save as Exception Image and click 

OK. 
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c. If a scanned test has a student number that does not appear in the loaded 

Acuity roster file, or if the student number is invalid, the Correct Data – 

Student Number dialog appears.  Click Save Exception Image and 

Discard. 

 

 
 

d. If a scanned test has a test number that does not appear in the loaded 

Acuity roster file, or if the test number is invalid, the Correct Data – Test 

Number dialog appears.  Click Save Exception Image and Discard. 

 

 
 

 

2. The Save As Exception dialog appears.  Choose a name for the exception image 

and browse to the desired folder in which to save the image. 
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3. Click Save to save the image and return to processing other images. 
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3.8 Discard Exception Images 
 

During the processing of the scanned images, data validation exceptions may occur.  One 

of the options for dealing with a data validation exception is to discard the exception 

images.  This removes the image from the current group of images, excludes the image 

from the export file, and indicates that the images can be safely discarded without being 

saved.   

 

To discard an exception image during processing, perform the following steps. 

 

1. For each image that has data validation errors, one or more of the following data 

validation dialogs will appear. 

 

a. If a scanned test is not of the same test template type chosen at the 

beginning of scanning, the Invalid Form Type dialog appears.  Choose 

Discard Image and click OK. 

 

 
 

b. If a scanned test has no filled in answers that can be detected, the No 

Answers dialog appears.  Choose Discard Image and click OK. 
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c. If a scanned test has a student number that does not appear in the loaded 

Acuity roster file, or if the student number is invalid, the Correct Data – 

Student Number dialog appears.  There is no option in this dialog to 

simply the discard the image.  It must be saved as an exception, as 

described in the previous section. 

 

 
 

d. If a scanned test has a test number that does not appear in the loaded 

Acuity roster file, or if the test number is invalid, the Correct Data – Test 

Number dialog appears.  Click There is no option in this dialog to simply 

the discard the image.  It must be saved as an exception, as described in 

the previous section. 

 

 
 

2. If the Discard Image option was chosen, that image is now removed from 

processing and no data will be exported for it. 
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3.9 Load Exception Images 
 

To load exception images that were previously saved into vCapture Express for Acuity, 

perform the following steps. 

 

1.  Select Load Exception Images… from the File menu to choose previously 

scanned .tif images that will be processed by vCapture Express for export to 

Acuity. 

 

 
 

2.  Clicking the menu item brings up the Open Exception Image dialog. 

 

 
 

3.  Select one or more images to load into vCapture Express for Acuity and click 

Open.   

 

4.  Each image is loaded into vCapture Express for Acuity as if it had just been 

scanned. 
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3.10  Discard All Current Images 
 

After scanning is complete, the Process Images button is enabled on the main toolbar.  

At this time, to discard all the images loaded in vCapture Express for Acuity, rather than 

processing them, perform the following steps. 

 

1. Click the Process Images button. 

 

 
 

2. The Process Images message box appears.  

 

 
 

3. Click the radio button next to No, save the scanned images for processing at a 

later time and reset vCapture Express. 

 

4. Click the OK button. 

 

5. vCapture Express for Acuity will save the images to the Archive path and reset. 
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4 Reference 
 

This section contains reference descriptions of the menus, tools, and dialogs in vCapture 

Express for Acuity. 

 

The main sections of this reference are as follows. 

 

• File Menu 

• Edit Menu 

• View Menu 

• Scan Menu 

• Help Menu 

• Main Toolbar 

• Validation Dialogs 
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4.1 File Menu 
 

The file menu contains options for interacting with files and closing vCapture Express for 

Acuity. 

 

 
 

The file menu contains the following options. 

 

• Load Roster 

• Print Tests 

• Load Exception Images 

• Exit 
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4.1.1 Load Roster… 
 

Select Load Roster… from the File menu to choose an Acuity roster file that vCapture 

Express for Acuity will use for pre-populating printed tests or validating scanned test 

data. 

 

 
 

Clicking the menu item brings up the Load Acuity Roster File.  The default directory 

was specified at install time.  If the desired roster file is not at this default directory, 

browse to the directory on the file system where the desired roster file is located. 

 

 
 

Select the desired roster file and click Open.   

If the roster file is correctly formatted, a message box appears to confirm this. 
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Click OK to confirm that the roster file was loaded. 

 

The status bar at the bottom of the screen is updated with the path of the loaded roster 

file. 
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4.1.2 Print Tests… 
 

Select Print Tests… from the File menu to print Acuity assessment test forms with or 

without pre-populated Student Numbers and Test Numbers. 

 

 
 

Clicking the menu item brings up the vCapture Express – Print dialog. 

 

 
 

In the Printer section, the current default printer is selected.  To choose a different 

printer, click on the drop down arrow and select the desired printer. 
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In the Test Template section, the current test template to be printed is selected.  To 

choose a different test template to print, click on the drop down arrow and select the 

desired test template. 

 

 
 

In the Roster File section, the path to the currently loaded Acuity roster file is displayed 

(if no roster file is loaded, this path is blank).  To load an Acuity roster file, click Browse 

and choose the desired roster file. 

 

Once a roster file is loaded, the checkbox Pre-populate forms from roster file is 

checked.  With this box checked, the student number and test number of each printed 

form will be filled out with one line from the roster file. 

 

If a roster file is loaded, the Test Number section is set to Use roster file to indicate that 

the pre-printed test number will be pulled from the lines of the roster file.  To override the 

test number(s) from the roster file, or if there is no roster file loaded, set the Test 

Number section to Specify and type in the desired test number. 

 

In the Copies section, if a roster file the Forms to print counter is disabled and the 

number of lines in the loaded roster file is displayed.  If no roster file is loaded, enter the 

desired number of forms to print. 

 

Click Print to initiate the printing process.  This brings up a dialog that displays the 

progress in preparing the forms that will be printed and sending the forms to Adobe 

Acrobat Reader for printing. 
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Once the forms have been prepared, Adobe Acrobat Reader is launched and the forms are 

sent to that application for printing. 

 

When the forms have been spooled to the printer, the progress dialog disappears and 

printing will begin when the printer is ready. 
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4.1.3 Load Exception Images… 
 

Select Load Exception Images… from the File menu to choose previously scanned .tif 

images that will be processed by vCapture Express for export to Acuity. 

 

 
 

Clicking the menu item brings up the Open Exception Image dialog. 

 

 
 

Select one or more images to load into vCapture Express for Acuity and click Open.  

Each image is loaded into vCapture Express for Acuity as if it had just been scanned. 
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4.1.4 Exit 
 

Select Exit from the File menu to close the vCapture Express for Acuity application. 

 

 
 

If there are currently images loaded in vCapture Express for Acuity, a message box 

appears to warn that these images will not be processed (but they are saved to disk for 

later processing). 

 

 
 

Click Yes to proceed with closing vCapture Express for Acuity. 
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4.2 Edit Menu 
 

In vCapture Express for Acuity, all items under the Edit menu are disabled at all times. 
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4.3 View Menu 
 

The view menu contains options for changing the layout and appearance of windows in 

vCapture Express for Acuity. 

 

 
 

The view menu contains the following options. 

 

• Images 

• Full Screen 
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4.3.1 Images 
 

Select Images from the View menu to toggle the appearance of the Images sidebar. 

 

 
 

When Images is selected, the Images sidebar appears in the main window to display the 

images that have been scanned. 
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4.3.2 Full Screen 

 
Select Full Screen from the View menu to cause the vCapture Express for Acuity main 

window to take over the entirety of the computer screen. 

 

 
 

Hit the F11 key to toggle between full screen and standard window mode. 
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4.4 Scan Menu 
 

The scan menu contains options for related to scanning in vCapture Express for Acuity. 

 

 
 

The scan menu contains the following options. 

 

• Choose Scanner 

• Hide Configuration 

• Scan 
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4.4.1 Choose Scanner… 
 

Select Choose Scanner from the Scan menu to change which scanner will be used by 

vCapture Express for Acuity if more than one scanner is available. 

 

 
 

Clicking the menu item brings up the Select Scanner dialog. 

 

 
 

Choose the scanner to be used and click Select to make the choice. 
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4.4.2 Hide Configuration 

 
Select Hide Configuration from the Scan menu to toggle whether the scanner’s 

configuration dialog should appear when scanning is initialized.  The default is for this to 

be toggled on such that the configuration will not appear. 
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4.4.3 Scan 

 
Select Scan from the Scan menu to initiate the process of scanning test forms into 

vCapture Express for Acuity for processing and export. 

 

 
 

Clicking the menu item brings up the Choose Form Template and Roster File dialog. 

 

 

 

In the Form Template section, choose the test template that matches ALL of the paper 

assessment tests to be scanned (All the tests to be scanned MUST be of the same template 

type). 

 

 

 

In the Roster File section, if the Acuity roster file that matches the tests to be scanned is 

not currently loaded, click the Browse button and choose the desired Acuity roster file. 

Click the OK button to begin scanning on the computer’s default scanner.  The toolbar 

will change with the Begin Scanning button becoming the Stop Scanning button.  It 

may take a few moments for the scanner to warm up. 

 

 
 

Once the scanner begins scanning, the images will begin to appear in vCapture Express 

one at a time. 

 



Copyright © 2008 by PaperFree Corporation 61

 
 

When the scanner has finished scanning, the Stop Scanning button becomes the Resume 

Scanning button, and the Process Images button is enabled. 
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4.5 Help Menu 
 

The help menu contains options for learning about vCapture Express for Acuity. 

 

 
 

The help menu contains the following options. 

 

• Help 

• About vCapture Express 
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4.5.1 Help 
 

Select Help from the Help menu to open the help file for vCapture Express for Acuity. 
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4.5.2 About vCapture Express 

 
Select About vCapture Express from the Help menu to see information about vCapture 

Express for Acuity. 

 

 
 

Clicking this menu item brings up the About dialog with information regarding the 

particular version of vCapture Express. 

 

 
 

Click OK to return to the application. 
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4.6 Main Toolbar 
 

The main toolbar appears at the top of the main window of vCapture Express for Acuity 

below the main menu. 

 

 
 

The main toolbar contains the following buttons. 

 

• Load Roster 

• Print Tests 

• Begin Scanning 

• Process Images 

• Fit To View 

• Zoom In 

• Zoom Out 
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4.6.1 Load Roster 
 

Click the Load Roster button from the main toolbar to choose an Acuity roster file that 

vCapture Express for Acuity will use for pre-populating printed tests or validating 

scanned test data. 

 

 
 

Clicking the toolbar item brings up the Load Acuity Roster File.  The default directory 

was specified at install time.  If the desired roster file is not at this default directory, 

browse to the directory on the file system where the desired roster file is located. 

 

 
 

Select the desired roster file and click Open.   

If the roster file is correctly formatted, a message box appears to confirm this. 

 

 
 

Click OK to confirm that the roster file was loaded. 

 

The status bar at the bottom of the screen is updated with the path of the loaded roster 

file. 
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4.6.2 Print Tests 
 

Click the Print Tests button on the main toolbar to print Acuity assessment test forms 

with or without pre-populated Student Numbers and Test Numbers. 

 

 
 

Clicking the toolbar button brings up the vCapture Express – Print dialog. 

 

 
 

In the Printer section, the current default printer is selected.  To choose a different 

printer, click on the drop down arrow and select the desired printer. 
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In the Test Template section, the current test template to be printed is selected.  To 

choose a different test template to print, click on the drop down arrow and select the 

desired test template. 

 

 
 

In the Roster File section, the path to the currently loaded Acuity roster file is displayed 

(if no roster file is loaded, this path is blank).  To load an Acuity roster file, click Browse 

and choose the desired roster file. 

 

Once a roster file is loaded, the checkbox Pre-populate forms from roster file is 

checked.  With this box checked, the student number and test number of each printed 

form will be filled out with one line from the roster file. 

 

If a roster file is loaded, the Test Number section is set to Use roster file to indicate that 

the pre-printed test number will be pulled from the lines of the roster file.  To override the 

test number(s) from the roster file, or if there is no roster file loaded, set the Test 

Number section to Specify and type in the desired test number. 

 

In the Copies section, if a roster file the Forms to print counter is disabled and the 

number of lines in the loaded roster file is displayed.  If no roster file is loaded, enter the 

desired number of forms to print. 

 

Click Print to initiate the printing process.  This brings up a dialog that displays the 

progress in preparing the forms that will be printed and sending the forms to Adobe 

Acrobat Reader for printing. 

 

 
 

Once the forms have been prepared, Adobe Acrobat Reader is launched and the forms are 

sent to that application for printing. 

 

When the forms have been spooled to the printer, the progress dialog disappears and 

printing will begin when the printer is ready. 
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4.6.3 Begin Scanning/Stop Scanning 
 

Click the Begin Scanning button on the main toolbar to initiate the process of scanning 

test forms into vCapture Express for Acuity for processing and export. 

 

 
 

Clicking the toolbar button brings up the Choose Form Template and Roster File 

dialog. 

 

 
 

In the Form Template section, choose the test template that matches ALL of the paper 

assessment tests to be scanned (All the tests to be scanned MUST be of the same template 

type). 

 

 
 

In the Roster File section, if the Acuity roster file that matches the tests to be scanned is 

not currently loaded, click the Browse button and choose the desired Acuity roster file. 

Click the OK button to begin scanning on the computer’s default scanner.  The toolbar 

will change with the Begin Scanning button becoming the Stop Scanning button.  It 

may take a few moments for the scanner to warm up. 
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Once the scanner begins scanning, the images will begin to appear in vCapture Express 

one at a time. 

 

 
 

When the scanner has finished scanning, the Stop Scanning button becomes the Resume 

Scanning button, and the Process Images button is enabled. 
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4.6.4 Process Images 
 

Click the Process Images button on the main toolbar to begin the data export process. 

 

 
 

The Process Images dialog appears.  Choose Yes to process the images at this time.  

Choose No to save the images for later processing and remove them from vCapture 

Express for Acuity.   

 

 
 

If a roster file is loaded, keep the Roster File checkbox checked to have all Student 

Numbers and Test Numbers validated against the roster file.  Uncheck this check box to 

not validate that the Student Numbers and Test Numbers appear in the roster file (use this 

option if more than a few student numbers being processed do not appear in the loaded 

roster file). 

 

The Processing Progress dialog appears and displays the progress through the steps of 

Preparing Images, Analyzing Images, Reading Data, and Completing. 
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If there are any data validation errors, the Invalid Data message box appears.  Click OK 

to continue.   

 

 
 

For each image that has data validation errors, one or more of the data validation dialogs 

will appear. 

 

After all data has been validated, or if there are no validation errors, the Data Capture 

Complete message box appears.  Click OK to choose an export file location. 

 

 
 

The Save Acuity Export File dialog appears.  Choose a location and file name (or accept 

the defaults) and click Save. 
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The Reset vCapture Express dialog appears.  Click Yes to reset vCapture Express for 

Acuity and complete the data export process. 
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4.6.5 Fit To View 
 

When an image is loaded in vCapture Express for Acuity, the Fit To View button can be 

clicked to reset the view of the image to include the entire image. 
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4.6.6 Zoom In 
 

When an image is loaded in vCapture Express for Acuity, the Zoom In button can be 

clicked to increase the size of the image in the main view. 
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4.6.7 Zoom Out 
 

When an image is loaded in vCapture Express for Acuity, the Zoom Out button can be 

clicked to decrease the size of the image in the main view. 
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4.7 Validation Dialogs 
 

During the processing of images in vCapture Express for Acuity, various types of 

validations of the images or data on the images may fail.  These failures cause one of the 

following four types of dialogs to be presented. 

• Invalid Form Type Dialog 

• No Answers Dialog 

• Invalid Student Number Dialog 

• Invalid Test Number Dialog 
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4.7.1 Invalid Form Type Dialog 
 

During the processing of images in vCapture Express for Acuity, if a test form is 

determined to be a form type other than the one that was expressly chosen in the Begin 

Scanning dialog, the Invalid Form Type dialog appears. 

 

 
 

Options when the Invalid Form Type dialog is presented 

 

1. Choose Discard Image and click OK.  This will remove the image from being 

processed and no result will be output for this image in the export file. 

2. Choose Save as Exception Image and click OK.  This will remove the image 

from being processed but save the image to a user-chosen location for loading and 

processing at a later time.  No result will be output for this image in the export file 

at this time. 

3. Click Cancel Processing.  This will return vCapture Express for Acuity to the 

post-scan state and discard any processing that has occurred to this point. 
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4.7.2 No Answers Dialog 
 

During the processing of images in vCapture Express for Acuity, if a test form is 

determined to have zero answer bubbles filled out, the No Answers dialog appears. 

 

 
 

Options when the No Answers dialog is presented 

 

4. Choose Discard Image and click OK.  This will remove the image from being 

processed and no result will be output for this image in the export file. 

5. Choose Save as Exception Image and click OK.  This will remove the image 

from being processed but save the image to a user-chosen location for loading and 

processing at a later time.  No result will be output for this image in the export file 

at this time. 

6. Click Cancel Processing.  This will return vCapture Express for Acuity to the 

post-scan state and discard any processing that has occurred to this point. 
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4.7.3 Invalid Student Number Dialog 
 

During the processing of images in vCapture Express for Acuity, a number of validations 

can fail that are related to the Student Number that is read from a test form.  If any of 

these validations fail, the Correct Data – Student Number dialog appears. 

 

 
 

Validations that can fail and present this dialog 

 

1. If an Acuity roster file is loaded, and the Use Roster File for Validations 

checkbox was checked in the Process Images dialog, the student number is 

validated to insure that it appears in the roster file. 

2. The student number must not be blank. 

3. The student number must not have any blank spaces in the middle. 

4. The student number must not have any columns that have multiple bubbles filled 

in. 

 

Options when the Correct Data – Student Number dialog is presented 

 

7. Enter the correct student number in the text box and click OK.  This will cause 

the entered student number to appear in the final export file in place of the read 

value. 

8. Click Ignore Issue to accept the read value in the export file. 

9. Click Save Exception Image and Discard to save the image to the file system 

and remove it from processing.  It will not appear in the export file. 

10. Click Cancel Processing to return to the post scan state and discard and 

processing that has occurred. 
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4.7.4 Invalid Test Number Dialog 
 

During the processing of images in vCapture Express for Acuity, a number of validations 

can fail that are related to the Test Number that is read from a test form.  If any of these 

validations fail, the Correct Data – Test Number dialog appears. 

 

 
 

Validations that can fail and present this dialog 

 

5. If an Acuity roster file is loaded, and the Use Roster File for Validations 

checkbox was checked in the Process Images dialog, the test number is validated 

to insure that it appears in the roster file. 

6. The test number must not be blank. 

7. The test number must not have any blank spaces in the middle. 

8. The test number must not have any columns that have multiple bubbles filled in. 

 

Options when the Correct Data – Test Number dialog is presented 

 

11. Enter the correct test number in the text box and click OK.  This will cause the 

entered test number to appear in the final export file in place of the read value. 

12. Click Ignore Issue to accept the read value in the export file. 

13. Click Save Exception Image and Discard to save the image to the file system 

and remove it from processing.  It will not appear in the export file. 

14. Click Cancel Processing to return to the post scan state and discard and 

processing that has occurred. 

 
  


